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Getting Started
Go to http://www.cityographer.com/download to download the latest version of Cityographer.  Installation 
instructions are there.  The inside back cover of this booklet has a license code.  Once launched you should see 
a window (known as the “start” or “setup” or “splash” screen) like this:

The first thing you'll want to do is click the Update your Cityographer License button.  A prompt will appear 
asking for your license number/code.  Again, it should be on the inside back cover of this booklet.  Enter the 
number, click “OK” and now you've got a Pro version of the software!

The quickest way to start a map is to just click the Create a New City in Just One Step button.  This will open a 
new window prompting for some details about the city you want to create:
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Below is short description of each field/option:
1. Enter a Population: This controls how many buildings are created.  Generally, there is one building 

added to the map for every 6 people.
2. Map width in hexes & Map height in hexes: The hex grid is off when the map is first shown, but you 

can turn it on by looking for a checkbox on the center left of the map edit window. (See below.)  If you 
make these values larger or smaller, your city/village will have more or less area.

3. Hex size in pixels: This is the height of each individual hex.  It doesn't affect the area of the city/village, 
it is treated as a zoom level.  If you increase this value, your buildings, roads, etc.  will look larger.

4. Chance of a harbor/coast: Set this to the percent chance you would like your city to have a harbor or 
coastline.  Depending on other random factors, it could be a harbor, peninsula or a simple coastline.

5. Chance of a River: Set this to the percent chance you would like a river in/near your city.
6. Chance City has a Wall (per 500 people): Take this value and multiply it by the population divided by 

500.  So if the city's population is set to 10000 and this is set to 5, the chance will be 20 x 5 = 100%.  Or 
if the population is 2500 and the city wall chance is 4, the chance is 5 x 4 = 20%.

7. Area Forest Percentage: How much of the map should be covered in forest, if possible.  If the map is 
full of buildings, there may not be enough space to fill the map as much as requested.

8. ($ Pro Feature) Use Default Data: You can override the settings used to determine the buildings used, 
residents generated, and store product lists by the random generators by changing “Use Default Data” 
to “Override Data” and choosing a properties file.  (From our map icon packs, the correct file to use 
ends with “data.properties”.)

9. ($ Pro Feature) Use Default Line Styles: As “Use Default Data” above, but this affects the line textures, 
widths, etc., for roads, walls, etc.  

10. ($ Pro Feature) Use Default Text Styles: As “Use Default Data” above, but this affects the text settings 
for labels.

11. ($ Pro Feature) Use Default Textures: As “Use Default Data” above, but this changes the textures used 
for filling in polygons and lines.

12. ($ Pro Feature) Use Default Map Items: As “Use Default Data” above, but this changes which buildings 
are available and the pictures used for each.

Clicking “OK” will temporarily show a status window, then result in a map like this:

Next, we'll create a map step by step.  Other sections in this booklet will detail the parts of the window above 
and how to make changes to the map and building details.
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Step-by-Step Map Creation Process
Note: Each of the subsections below describes how to do each step in a completely custom way in addition to  
the automated, random method.
If we choose the “Create a New City Step-by-Step” from the start/splash screen, we see a window like this: 

This is similar to the “Create a New Complete City” window except a few fields are omitted.  Those fields are 
not needed here because those values are specified in later steps. Accepting the defaults and clicking “OK” 
brings us to a blank screen like this:

Creating a city is a 6 step process:
1. Create the harbor/coast (if you want one.)
2. Create a river (if you want one.)
3. Create the highways (major roads.) This step is essential as it creates two larger roads which are used to 

determine the city center.  (Where they meet.)  If you city doesn't have a crossing of two major roads, 
you can fake this out by drawing the two major roads as a small “X”.

4. Create the street network.
5. Add Buildings.
6. Add vegetation.

4



Create the Harbor/Coast
To have the system generate a harbor or coastline, go to the “Generate” menu and choose “Harbor/Coast” and 
you will see a window like this:

Play with the options here.  As the instructions explain, set the “From” and “To” to the number of degrees 
around the map where there should be water.  Then select “Generate”.
Go to the “Edit” menu and select “Undo” if you'd like to undo the generated harbor and try again.

You can also create it by hand by going to the “Shapes” tab on the right of the map edit window.  Select 
“Polygon” then set the colors as desired.  Check the box for “Is Passable”.  This is used to ensure no buildings or 
small streets cross the polygon.  See the “Drawing Shapes” section of this booklet for more details.

Create A River
Go to the “Generate” menu and choose “River” to have the system generate a river. A dialog like this appears:

This allows you to customize your river.  It is still random, but subject to the parameters you choose.  The 
“River starts at” and “River ends at” fields have values that correspond to clock positions.  12:00 is the top 
center of the map, 3:00 is the center right and so on.  The “River Thickness” lets you specify how wide the river 
is and the “Segment Length” determines how long the river is before it might have a bend.  Finally 
“Straightness” determines how much it bends.  “5” gives a fairly organic looking result.  A higher number such 
as “15” results in nearly straight rivers.

To create a completely custom river, go to the “Shapes” tab on the right of the map edit window.  Select 
“Polygon” then set the colors as desired.  Check the box for “Is Passable”.  This is used to ensure no buildings or 
small streets cross the polygon.  (This process is similar to what is done for a custom harbor/coastline.
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Create the Highways (Major Roads)
On the “Generate” menu choose “Highways” to see the dialog below:

The first four controls allow you to set where on the map the two roads start and end.  As with rivers, the 
options are based on clock positions.  The street segment length and straightness are similar to what they do 
for a river. (See the section above.)

To make custom highways, go to the “Styled Lines” tab on the right side. Mouse over the line buttons at the 
top of the tab area until you see the one that says “highway.”  Choose it.  Draw your two lines on the map by 
either clicking point to point or simply dragging.  Click the “New Line” button to start a new line.  See the 
“Drawing Lines” section of this booklet for more details.

Create the Streets
On the “Generate” menu choose “Streets” to see the dialog below:

The first option determines which other options to use. You can set it to a “Haphazard” layout for a more 
organic street network or to “Planned” for a city with streets that are grid-like.  The haphazard settings simply 
let you specify how many streets to add.  The planned settings need a bit more explanation:

• Is Circular: If true, it will cut the outer streets a bit so the resulting city is more circular in overall shape.
• Street Segment Length:  How many hexes long a street segment will be.
• #Streets Away From Intersection: How many streets to place on each side of the intersection along 

each highway.
• Length of Streets: How long each street is by segments.  (So a 5 segment street where each segment is 

6 hexes will be 30 hexes long.
• % Skip Road: Chance that a road will be skipped in the layout. (Leaving a section of larger city blocks.)
• % Hex Randomness:
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To add streets by hand, go to the “Styled Lines” tab on the right side. Mouse over the line buttons at the top of 
the tab area until you see the one that says “road.”  Choose it.  Draw your streets on the map by either clicking 
point to point or simply dragging.  Click the “New Line” button to start a new street.  See the “Drawing Lines” 
section of this booklet for more details.

Add Buildings
On the “Generate” menu, select “Buildings” to get to this dialog:

This dialog is used to add buildings to the map. Below is an explanation of each column:
• Building Type: The name of the building to add with the properties in the rest of the row.
• Size (% of image): The built-in art (and the art in the icon packs) is mostly (with a few exceptions) on the 

same scale.  If for some reason you want some larger buildings or you import other art that has a 
different scale, you can change it here.

• On Road: Do these buildings  need to be placed on a road?
• Farm: Is this building a farm?
• Placement: Options are: No Restrictions, Near Center, and Away From Center.  Near Center and Away 

From Center force the buildings to be within or beyond a specific number of hexes from the city center.
• Allowed Distance: If Placement is “Near Center” then the buildings will be placed within this number of 

hexes from the center.  If Placement is “Away From Center” buildings will be beyond that point.
• Densely Packed: If buildings overlap on initial placement, instead of trying again from scratch, try again 

slightly to the side.
• # Buildings: Number of buildings to place with these settings.  You can use the same building type on 

multiple rows if you want to place some with different settings.
To add buildings manually, go to the “Map Items” tab on the right and select a building then click where you'd 
like it on the map.  For more details (including editing any buildings on the map) see the “Placing Map Items” 
section.

Adding Vegetation:
This is identical to placing buildings, but you are given options with trees.
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Main Map Edit Window
As shown previously, the main map window looks like this (yours may have a city already in it):

At the top of the window are a number of menus.  See page 16 for details.  The center area is your map 
view/edit area.  It is scrollable (note the scroll bars just below and just to the left of the map.)  
To the right of the map are a few buttons with different line styles. See the “Drawing Lines” section for details.

On the far right are a number of tabs.  (These may look different or have a different layout depending on your 
computer operating system.)  The tabs let you switch from drawing lines to , placing text, shapes or map items. 
Each of these functions is described in detail in later sections.

To the left of the map are a number of checkboxes and controls.   These are detailed starting on page 18.
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Placing Map Items
The Map Items tab holds a variety of additional map objects that greatly enhance the map. Most notably, 
there is a selection of predefined buildings. Each map item can be edited using the controls near the bottom of 
the tab area:
Width, Height — These two fields control the scaling of new map items as they are added. These values are 
expressed as percentages and work independently of each other. Width and height are percentages relative to  
the current hexagon size.
Rotation — A map item may be rotated. The selected item is rotated by setting a value in this field. The value is 
in degrees, counter-clockwise from horizontal and rotating about the select square in the middle of the item.
Label — Add text to the bottom of the map item.  The adjacent color choosers change the text color and 
background color respectively.
Snap to Grid Quadrant — By default, map items are centered exactly where the mouse click places them. 
Checking this box shifts the placed item to the nearest of the hexagon center, a vertex, or the center of a 
hexagon side.
Select Map Item — Change or delete an existing item by selecting it. Click the Select Map Item button and all  
items in the window display a small yellow selection box; click on a particular item and its box turns blue. The  
item is now selected and its information (width, texture, etc.) displayed in the appropriate areas of the tab.
The Select Map Item button remains selected. Quickly remove multiple items (while the button is gray) by  
clicking the item, clicking Delete Selected, and repeating as often as desired.
New Map Item — Clicking this ensures that changes to item settings only apply to new items.
Move Selected to Front/Back — Multiple items may be placed in a hexagon, and items may be scaled to 
exceed the hexagon dimensions. These two buttons allow simple rearrangement of the stacking order, putting 
the selected item at the top or bottom of the stack.
GM Only — Check this box if you want the map item to disappear when the “Show GM Only Objects” checkbox (center 
left of the map edit window) is not selected.
Delete Selected  — Deletes the currently selected map item from the map.  You may also press your computer's “Delete” 
key when a map item is selected.

9



Drawing Lines

Styled Lines
A city or village map contains city walls and roads These elements are best represented by Styled Lines. To 
create a styled line, go to the “Styled Lines” tab on the far right and then choose one of the line buttons at the 
top.  Leave your mouse over a button for a second or two and a tool-tip appears that tells you the name of the 
lines style.  (“Wall” or “Highway” for example.) 
Select the desired line type and click on the map to draw lines. Once a line is complete (start a new one by 
clicking the “New Line” button or click the “Select Line” button) individual line points may be moved using a 
secondary (right-click) drag of the vertex.

There are several other controls on the “Styled Lines” tab that assist drawing lines:
Line Behavior— Basic, Fractal, or Curve; this allows you to create other line types.  A fractal line will have a 
number of chaotic points added between the points you place.  A curve will use every 3 points to create a 
curve, not including an initial anchor point.
GM Only — Boundaries, roads, and in fact any and all lines may be drawn with the GM Only box checked. 
Lines added with this box checked are visible only when enabled in the Show/Hide box.
Snap Line Points — If this checkbox is checked, the line's points will be moved to the closest hex vertex or half-
way or quarter-way point.
Invert Hashes — Detailed maps often include an indication of elevation changes. Cityographer does this by 
drawing a solid line and adding small “hash” marks to one side. These smaller lines traditionally indicate the 
downhill side of the line. Since Cityographer can’t tell which side is downhill, an Invert Hashes button is 
provided.
Select the desired line (Select Line, below), and click on Invert Hashes.

 

Before and after Invert Hashes

New Line — When drawing a line, each click of the mouse (or click-drag for freehand) adds another point to 
the line. Clicking New Line indicates to Cityographer that the current line is complete and a new line will begin.
Remove Last Point — While a line is selected (see below), clicking the Remove Last Point icon deletes the last 
point of the line. This icon may be clicked as often as necessary. Consider redrawing the line (Select Line, then 
Delete Selected Line) if many points need removal.
Select Line — Select a line by clicking on the Select Line icon, then clicking on the desired line on the map. The 
line may be removed, moved to the front or back of the drawing stack, or the last point removed. A line must 
also be selected to edit a vertex.
Move Selected to Front/Back — When two lines intersect, the mapmaker may change the stacking or drawing 
order of the two lines. The order determines which is in front (on top.)

 

Move to Front or Back

In the example above, the red line is in front in the left image, in back in the right.
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Delete Selected Line — Remove lines by clicking Select Line, choosing the line, then clicking Delete Selected 
Line.

 

Selected and deleted line

In the example above, a red line is selected and then deleted.

Custom Lines
The Custom Lines tab provides additional line tools for the mapmaker. This tab includes the same Line 
Behavior, Snap Line Points, Invert Hashes, Snap Line Points,New Line, Remove Last Point, Select Line, Move 
Selected to Front/Back, and Delete Selected Line icons as in the Styled Lines tab. This tab, however, features 
custom line width, line type, and colors as well as offering multiple Type: tags to categorize the new lines.
Color — New lines are drawn in the current color. See Color Picker below for details on selecting custom colors.
Width — Lines are drawn at the width (or thickness) specified in this field. As usual, a value may be entered 
directly or reached by clicking the up and down arrows.
Line Type — The type of line drawn (solid, dashed, dotted, or hashed) is determined by the choice in the 
menu.
Type — Lines added in this tab may be associated with one or more of the types listed (or none at all). Each of 
the types has a matching show/hide checkbox on the other side of the Hexographer window. The types 
suggest possible uses of the lines (natural, political, infrastructure, GM only) for the mapmaker, but the only 
real difference is the show/hide checkbox to which they are assigned.

Line Editing
To edit a line, first select it by clicking the Select Line button then clicking on the line.  If selected, the line's 
points will appear as dots.
Extend Line – Click an end point and then click or drag to add more points.
Remove Point – Right-click the point.
Add Point – Shift-click at the new point's desired location.  It is added to the line between the line's two 
closest already existing points.
Move Point – Right-press on the point (don't right-click as that removes the point) and drag it to the desired 
spot.
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Placing Text

Styled Text
A good map needs labels that identify both the physical and the political aspects of the terrain. Cityographer 
provides for this need in the Styled Text tab.  This tab lets the mapmaker select a label category and enter the 
actual text; the Configure → Lines menu item (see page 16) controls how that category of text is displayed on 
the map.
Changing the settings for a style changes the appearance of every instance of that style on the map. For 
example, changing the size of “large” (in Configure → Lines) changes every “large” label on the map.
In general, the procedure for adding a text label is this:

1. Select the label category.
2. Type the text.
3. Click on the map to place the text.
4. Click on Save to deselect the label.

The text may be moved about the map (while selected) by a click-drag on the dark square at the lower-left of 
the text field.
Select Text — Change an existing text by selecting it. Click the Select Text button and all text fields in the 
window get a small selection box; click on a particular text and the box fills and the text is surrounded by a thin 
outline. This indicates that the text is selected.

    

Text labels: normal, available, selected

The example above shows a label as it might appear on a map. The second image is the same label 
immediately after clicking the Select Text button, indicating that it is available for selection. A selected label is 
shown on the right.
Once the label is selected, it may be moved by a click-drag on the solid square (lower left of the label) and the 
content changed by editing the text in the field beside the Save button.
Styles —  Styles with “natural”, “political”, and “infrastructure” in their labels are automatically assigned to the 
appropriate Show/Hide category. Using the show/hide checkboxes to the left of the map allows you to have a 
geographical-only map, or a map without political bounds, etc.
GM Only — Text added with this box checked is visible only when enabled in the Show/Hide box.
Rotate — If the mapmaker desires, a label may be rotated to better align with the terrain element to which it is 
associated. To rotate a label, select it and set a value in this text field. The value is in degrees, clockwise from 
horizontal and rotating about the select square at the lower left of the label.
Delete Selected — Once a label is selected, clicking on the Delete Selected icon removes it from the map.

Custom Text
In addition to the built-in text styles, Cityographer allows the mapmaker to insert text with custom styles 
applied.
Select the Custom Text tab, click Start New Text and enter the desired label in the Text: field. Click on the map 
to place the label. The label may be modified for color, size, style, and font. The text may be outlined in the 
selected color, rotated, and/or assigned to one or more of four categories. Click Save or Start New Text when 
satisfied.
Start New Text — Clicking this button deselects any active text and prepares Cityographer to place new text.
Delete Text — A selected text (one showing the active-block and an outline) is removed from the map.
Color: — Select a fill color (foreground color) for the active text. The painter's palette opens a color selector 
dialog.  The color on the bottom of the palette is the currently selected color. 
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Size: — This field determines the point size of the text. This size applies to the current zoom level and the text 
will appear smaller as the mapmaker zooms out.
Style: — Depending on the options available for the selected font, styles may include bold, italic, etc 
Font: — The range of fonts available for new text depends upon the system configuration. The choices appear 
when the menu button is selected. The current font name is displayed in the menu button.
Outline: — This color selection works in conjunction with the Size: field beside it. The color selected outlines 
the placed text if the size is not zero.
Text: — The Text field holds the actual text placed when the mapmaker clicks on the map. The text may be 
changed at any time and while the map text is active, the content on the map will change to match. The 
mapmaker must click on Start New Text or Save to deselect the field.
Save — The Save button deselects the currently active text field. The Text field may then be changed without 
effect on the map.
Type: — If any of these boxes are checked, the active text is attached to the appropriate Show/Hide category. If 
no box is checked, the text is visible regardless of the Show/Hide boxes.
Rotate — If the mapmaker desires, a text label may be rotated to better align with the terrain element to 
which it is associated. To rotate, select the text and set a value in this field. The value is in degrees, clockwise 
from horizontal and rotating about the select square at the lower left of the text.
Select Text — Change an existing text by selecting it. Click the Select Text button and all text fields in the 
window get a small selection box; click on a particular text and the box fills and the text is surrounded by a thin 
outline. This indicates that the text is selected.
Delete Selected — Once a text field is selected, clicking on the Delete Selected icon removes it from the map.
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Drawing Shapes
Large shapes are placed on the map using the Shapes tab. These shapes are separate from the terrain and may 
be placed either above or below the terrain by choosing the appropriate option. See the Layers Diagram for 
more information.
Shapes are divided into two categories: Polygon and Oval. Polygonal shapes are constructed of line segments, 
the vertices set by clicking the mouse. Oval shapes are described by a starting angle and the number of 
degrees (counter-clockwise) they extend from that starting point. Ovals also have a choice of Closure styles.
Start Angle: – A start angle of 0° is interpreted to be 3:00 on a clock face.
Angle Extent: — This field specifies the number of sweep degrees over which an oval is drawn, beginning with 
the Start Angle and extending counter-clockwise.

Start Angle: 0°, Angle Extent 270°

The example above is an oval that begins at Start Angle of 0° and has an Angle Extent of 270°. It has a Color 
Fill of dark gray and a Color Border of black.

Start Angle: 90°, Angle Extent 180°

This example begins at 90° and sweeps through 180°.
Dragging the corner of the rectangle that contains the oval allows the creation of non-circular shapes, although 
the major and minor axes of the oval remain vertical and horizontal.
Closure: — The closure style of the oval (assuming the extent is less than 360°) may be chosen from Open (no 
border drawn), Chord (line between beginning and end), and Pie (straight lines from start to center to end). 
See below for examples.

  

Start Angle 90°, Angle Extent 90°: Open, Chord, Pie closures

All other options and controls for shapes are the same whether Polygon or Oval is selected.
Color Border: — A shape has a border unless the width is set to 0 (zero). The border itself may be selected 
using the Color Border icon or by selecting one of the Texture Border choices from the menu. 
Texture Border: — This option draws a border around the shape in the color determined by the popup menu.
Border Width: — The Border Width field determines the thickness in pixels of the line drawn around a shape. 
Set this value to zero if no border is desired.
No Fill — A shape may have No Fill and be a border only. It may have a solid Color Fill chosen via the Color 
Picker (see below) or have a Texture Fill chosen from the menu. The opacity is set by the Fill Opacity field. Set 
to 100, the filling completely blocks the terrain; setting the opacity to a lower number allows some amount of 
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the terrain to be visible through the fill.
Color Fill: — A shape may be filled with a solid color by checking this option and using the Color Picker to 
select the fill color. See also Fill Opacity below.
Texture Fill: — This option allows you to choose a texture to fill the shape. 
Fill Opacity: — Shapes with a fill enabled may also control the opacity of the fill. The default is 100%, with any 
terrain below the shape being completely  masked. Settings below 100 allow increasing amounts of the terrain 
to show through.
Snap To Quarter/Half/Vertex — If this checkbox is checked, the shape's points will be moved to the closest 
hex vertex or half-way or quarter-way point.
Is Impassable — Check this if buildings and roads (though not large highways that could have bridges) should 
not cross this shape when placed by the Cityographer's automatic street and building placement. 
Select Shape — To delete a shape or change its border or fill components, click Select Shape then click on the 
target polygon or oval shape.
Remove Last Pt — Once a shape is selected, this button removes the last point of the shape. This is most 
useful when working on a polygon. Ovals are determined by only two points.
Delete Selected Shape — A selected shape is removed by clicking this button. If no shape is selected, it has no 
effect.
Move Shape to Front/Back — Within the shape layer, the stacking order determines how overlapping shapes 
are displayed. Moving the shape to the front places it on top of all other shapes; moving it to the back puts it 
behind the others. See Styled Lines for an example.
Save — The Save button, as in other tabs, is a way to indicate to Cityographer that the mapmaker has finished 
working on a particular shape. It may be thought of as a “deselect” button.
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Menu Bar
Some special features are accessible only from the menus at the top of the window.

File Menu
The File Menu deals with saving or exporting the map in various ways. 

• New — Create a new map.
• Save — The map file is updated with the latest changes.
• Save As… — The mapmaker is offered the chance to rename the map file or save it to a new location.
• Export Current Size as PNG Image — The entire map is converted to a PNG image at the default size.
• Resize and Export as PNG Image — The entire map is converted to a PNG image after the mapmaker 

selects both the desired number of hexagons per inch and the resolution (in DPI) of the image.
• Select Area, Resize and Export as PNG Image — After selecting this option, the mapmaker may drag a 

selection box across the map (and the map may be panned and zoomed) to save a portion of the 
current map. Both the desired number of hexagons per inch and the resolution (in DPI) may be 
selected.

• Export Notes as basic HTML — All notes associated with map hexes are extracted and placed into a 
simple HTML file. See below for help adding notes to the map. 

• Upload — Quickly share your map by posting it to our website.  You'll be given a web addres and others 
can go there to see your map. You can upload your entire map or a portion.  (The map/area you select 
is scaled down to conserve space.)

• Quick Upload — Like upload, but it automatically uploads the same map area you previously uploaded.
• Print — The entire map is printed after the mapmaker selects both the desired number of hexagons 

per inch and the resolution (in DPI) of the output.
• Select and Print Area — As with the export option above, an area of the map is selected for printing 

and both the desired number of hexagons per inch and the resolution (in DPI) of the output.

Edit Menu
The Edit Menu provides undo and redo functionality.

Configure Menu
The Configure Menu allows you to change the map items (buildings, trees, etc.), line styles, text styles, 
textures, hex grid, and numbering.

Each of the above items has its own menu item and choosing to configure it (Line Styles for example) opens a 
new dialog like this one:

The main part of the window allows you to edit the existing settings.  Clicking the “Add Row” button allows you 
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to add a new line style to the list.  Export Settings and Import Settings allow you to re-use these settings for 
other maps.  Simply export the settings you like to a file ending in “.properties” and import it into another 
map.  Use “Apply & Close” to put your changes into effect or simply choose “Close” to not let changes take 
effect.

Generate Menu
The Generate Menu was detailed on pages 6 through 9.

Help Menu
The Help Menu provides useful information about Cityographer.

• About — The version number and build date are shown here as well as contact and copyright 
information.

• Display Java Version — Cityographer is a Java application. The version of Java currently running on the 
mapmaker’s computer is shown here as well as tips on getting the latest version.

• Report a Bug — This option displays the email address used to report bugs in Cityographer as well as 
some tips on how best to describe any problems encountered.
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Left-side Controls

Scroll Window/Overview Map/Mini-Map
The Scroll Window gives the mapmaker a graphic representation of area in the editor window versus the total 
map. Click-drag the rectangle to view other portions of the map. See also the Scroll/Pan button  (below.)

+ and – (aka “Zoom”) Buttons
The magnification of the map portion displayed in the editor window may be changed in easy steps with these 
buttons. The “+” button zooms in, the “-“ button zooms out. Zooming out is set to 10 pixels per hexagon. 

Scroll/Pan

Selecting the “pan” button ( ) changes the click-drag action in the editor window from the default terrain 
editing function to a scroll pointer. Click-drag to slide the display around the map.

Hexagon Size Control
The width of a hexagon in the edit window is normally under the control of Cityographer. These values change 
as the mapmaker zooms in and out. There are occasions, however, when the mapmaker may wish to take 
direct control over the hex size.  The width may be made less than 10.

View/Add/Edit Note 
In Cityographer, notes are added to every building when it is placed.  Clicking the  View/Add/Edit Note button 
adds selection handles on each building.  You can click on any building to see and edit the building's details: 
who lives there or what is for sale (if a store) or how much a room costs (if an inn), etc.

Location of the View/Add/Edit Note button.

To find a particular building type (just inns, for example) use the drop down next to the  View/Add/Edit Note 
button and select “Inn”.
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Drinks available at “The Silver Barrel”.

The data generated for any building's note can be revised by hand or regenerated in full or by sections.  To 
generate a new title (Inn name in this case), click the “Regen Title” button.  Or just type the name you want in 
place of the current name.  
If you would like to regenerate one tab of data, click the “Regenerate This Tab” when viewing the tab you wish 
to revise.  Or hand edit the rows as desired.  If you want to redo the entire building, click the “(Re)Generate” 
button.

Show GM Only Objects
Mapmakers have the option of marking any map element as visible to the “GM Only”. Checking this box on the 
left panel of Hexographer displays those items. A Game Master (GM) would presumably desire a map with all 
the elements visible. A map for players can be produced by unchecking this box before export.

Show/Hide Features
A series of check boxes in this section determine which map elements are displayed. As with “GM Only”, the 
Show/Hide check boxes control the display of a variety of features.

• Natural, Political, and Infrastructure Features — Select elements (added in Custom Text and Custom 
Line tabs below) may be displayed or hidden by category.

• Grid — This box controls the drawing of the hexagon outlines. The color of the grid is selected in the 
Configure  menu's Grid dialog.

• Grid Numbers — Turns hex coordinates on and off with this checkbox. The grid numbers are configured 
in the Configure Numbering tab, detailed further below.

• Dot in Center — A centered dot may be displayed in each hexagon by checking this box. The color is the 
same as the selected grid color.
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Frequently Asked Questions
1. I see the following prompt when I first launch.  What does it mean? Depending on your computer 

type and how you installed the program, you may be prompted to select an amount of memory for 
Cityographer to use:

Cityographer uses Java, and Java needs to declare how much memory it will use.  (Non-Java programs 
are able to ask for more memory as needed.)  Further, Java needs this memory to be contiguous.  So 
even if you have 16.0GB on your computer, if you have several programs running (or had a bunch 
running before and closed many) your computer may not have a single section of memory of the size 
requested.  Choose a smaller amount or restart your computer to reset your memory.  

2. Can I publish maps made with the software?  Yes!  We love to get credit (something like “Map made 
with Cityographer” in the caption or in the credits, but even that is just a request.  We do require that 
you only redistribute the art as part of a real map--Not as stock art or something like stock art.

3. I want to add my own graphics.  How should I prepare them? We size them so a regular house is 
about 200 pixels on the larger size.  This ensures even if the map is printed at 1”/hex, the graphics look 
crisp.  Larger buildings are proportionally larger although we don't match the scale for especially large 
buildings.  We make them transparent PNGs so the unused area stays transparent.
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